
INSTALLATION MANUAL
LG MultiSITE™ Supervisor



The instructions included in this manual must be followed to prevent prod-
uct malfunction, property damage, injury, or death to the user or other 
people. Incorrect operation due to ignoring any instructions will cause 
harm or damage. A summary of safety precautions begins on page 4. 

Do not throw away, destroy, or lose this manual. 
Please read carefully and store in a safe place for future reference.  

Content familiarity required for proper installation.

For more technical materials such as submittals, engineering  
databooks, and catalogs, visit www.lghvac.com.

For continual product development, LG Electronics U.S.A., Inc., reserves the right to change specifications without notice.  

©LG Electronics U.S.A., Inc.  

This document, as well as all reports, illustrations, data, information, and other materials are the property of LG Electronics U.S.A., Inc.

PROPRIETARY DATA NOTICE
This document, as well as all reports, illustrations, data, information, and other 

materials are the property of LG Electronics U.S.A., Inc., and are  
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TABLE OF SYMBOLS

The instructions below must be followed to prevent product malfunction, property damage, injury or death to the user or other people. Incor-
rect operation due to ignoring any instructions will cause harm or damage. The level of seriousness is classified by the symbols described 
below.

SAFETY INSTRUCTIONS

DANGER This symbol indicates an imminently hazardous situation which, if not avoided, will result in death or 
serious injury.

WARNING This symbol indicates a potentially hazardous situation which, if not avoided, could result in death or 
serious injury.

CAUTION This symbol indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury.  

Note: This symbol indicates situations that may result in equipment or property damage accidents only.

This symbol indicates an action that should not be performed.

 Do not use or store flammable gas or combustibles near the unit. 
There is risk of fire, explosion, and physical injury or death. 

Disconnect power before installing or servicing the unit.
There is risk of physical injury or death due to electric shock. 

  Do not touch any exposed outdoor unit wiring, terminals, or other electrical components with tools or exposed skin. Only 
qualified technicians should install, use, or remove this unit. 
Improper installation or use may result in  fire, explosion, electric shock, physical injury and/or death.

DANGER

This manual provides instructions on how to install LG MultiSITE™ Supervisor software for LG MultiSITE™ VM3 controller. It also includes 
information on system and license requirements, how to get started with MultiSITE Supervisor, descriptions of the MultiSITE Supervisor direc-
tory structure, and Niagara homes.

Refer to the LG MultiSITE VM3 Installation Manual for installation and mounting instructions of the controller.
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All electric work must be performed by a licensed electrician and conform to local building codes or, in the absence of  
local codes, with the National Electrical Code, and the instructions given in this manual. 
If the power source capacity is inadequate or the electric work is not performed properly, it may result in fire, electric shock, physical injury or death.

Do not change the settings of the protection devices.
If the pressure switch, thermal switch, or other protection device is shorted and forced to operate improperly, or parts other than those specified by 
LG are used, there is risk of fire, electric shock, explosion, and physical injury or death.

Dispose of any packing materials safely.
•	Packing materials, such as nails and other metal or wooden parts may cause puncture wounds or other injuries.
•	Tear apart and throw away plastic packaging bags so that children may not play with them and risk suffocation and death.

Do not install the MultiSITE VM3 unit if it will be exposed to rain or other precipitation. Do not install the unit in a 
location exposed to open flame or extreme heat. Do not touch the unit with wet hands.
There is risk of fire, electric shock, physical injury and/or death.

WARNING

Wear protective gloves when handling equipment.
Sharp edges may cause personal injury.

CAUTION

SAFETY INSTRUCTIONS
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Note:
Disconnect power before installing or servicing the unit.
There is risk of equipment damage or degraded performance. 

MultiSITE VM3 unit is for use with select LG air conditioning systems only. Do not attempt to use this unit  with any other 
type of system. 
There is risk of equipment damage or degraded performance. 

Clean up the site after all procedures are finished, and check that no metal scraps, screws, or bits of wiring have been left 
inside or surrounding the controller or indoor units.

Do not allow water, dirt, or animals to enter the controller.
There is risk of unit failure or degraded performance.

Do not spill water or other liquid on the inside of the controller. Do not drop the controller into water. If the unit is 
immersed in water or other liquid, contact your local authorized LG distributor for support.
There is risk of unit failure or degraded performance.

Remove all power to controller before attaching (plug in) or detaching (unplug) any option module. 
There is risk of possible equipment damage.

Do not remove the controller’s cover. 
No configurable or user-serviceable items (such as jumpers or a battery) require cover removal. All items are accessible as switches and connectors 
on the unit’s top, bottom, and side, or behind the unit’s front access door or microSD card shutter.

This device is only intended for use as a monitoring and control device. Do not use it for any other purpose.
There is risk of data loss or equipment damage.

Before removing or inserting the microSD card, disconnect all power to the controller and use static discharge precautions. 
There is risk of equipment damage.

The MultiSITE VM3 unit is not compatible with a Power-Over-Ethernet (POE) network. Do not connect the controller on a 
network segment which carries power. 
The unit may fail.

SAFETY INSTRUCTIONS
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The MultiSITE VM3 controller has the following agency listings, compliances, and certifications:
•	 UL-916, Energy Management Equipment - Edition 4
•	 FCC Part 15, Class B - Federal Communications Commission, with FCC Part 15, Subpart C - WiFi
•	 ICES-003, Class B - Industry Canada Interference-Causing Equipment Standard
•	 RoHS 2 (Restriction of Hazardous Substances), Directive 2011/65/EU.

                CE Declaration of Conformity (Council Directive 004-108-EC)

                   ACMA, complies with the requirements of the relevant ACMA Standards. This document covers mounting and wiring of the fol-
lowing products.

CERTIFICATIONS
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Federal Communications Commission (FCC)
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and

2. This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the 
equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates uses 
and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to 
radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause 
harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to 
try to correct the interference by one of the following measures:

•	 Reorient or relocate the receiving antenna.
•	 Increase the separation between the equipment and receiver.
•	 Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
•	 Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications (DOC)
This device complies with Industry Canada License-exempt RSS standard(s). Operation is subject to the following two conditions: 1) this de-
vice may not cause interference, and 2) this device must accept any interference, including interference that may cause undesired operation 
of the device.

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser) gain ap-
proved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type and its gain should be 
so chosen that the equivalent isotropically radiated power (EIRP) is not more than that necessary for successful communication.

The device for operation in the band 5150–5250 MHz is only for indoor use to reduce the potential for harmful interference to co-channel 
mobile satellite systems.

Approved Antenna Listing
•	 ANT-DB1-RAF-RPS

Transmitter Module Listing
•	 Contains Transmitter Module FCC ID: W98-12977
•	 Contains Transmitter Module IC: 8339A-12977

To comply with FCC and Industry Canada RF exposure limits for general population /uncontrolled exposure, the antenna(s) used for this 
transmitter must be installed to provide a separation distance of at least 20 cm from all persons and must not be co-located or operating in 
conjunction with any other antenna or transmitter.

COMPLIANCE AND APPROVALS
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INTRODUCTION

This manual provides instructions on how to install LG MultiSITE™ Supervisor software for LG MultiSITE™ VM3 controller. The manual also 
includes information on system and license requirements, how to get started with MultiSITE Supervisor, descriptions of the MultiSITE Super-
visor directory structure, and Niagara homes.

LG MultiSITE™ Supervisor will be referred to as MultiSITE Supervisor in this manual. LG MultiSITE™ VM3 will be referred to as MultiSITE 
VM3 in this manual.

MultiSITE Supervisor installation quick summary
1.	 Download the latest build.
2.	 Run the appropriate (32–bit or 64–bit) Installer and follow the installation wizard steps to define the requested information, such as the 

following:
•	 Installation location.
•	 Installation options including the installation of start menu and desktop shortcuts, and tiles.
•	 Finish install options, including whether to launch MultiSITE Supervisor after installation and load the start platform daemon.

For more information on installer type, refer to the section on 32-bit vs. 64-bit installations. 
3.	 Launch MultiSITE Supervisor and confirm license.

Minimum prerequisites
Before initiating MultiSITE Supervisor installation, verify that you meet all hardware and software requirements described in this section.

The Niagara Framework® requires an adequate processor, hard disk, memory and speed to run complex building models. Following are the 
minimum hardware requirements:

•	 Processor: Intel Pentium Core 2 Duo (32-bit or 64-bit), 2GHz
•	 RAM Memory: 2GB, with 8GB recommended if a 64-bit installation
•	 Hard drive space: 2GB available, 10GB recommended for any Supervisor
•	 Ethernet 100 Mbit or 1Gbit NIC (network interface card) with TCP/IP support
•	 Valid license
•	 Internet access for confirming your license.

As a multi-threading Java application, the Niagara Framework® can take advantage of the added power available in multi-core processors. 
A processor that goes beyond minimum requirements, such as the current Intel Core i3, i5, i7 or AMD A6, A8, A10 series processors, can 
provide performance benefits.

 

LonWorks® 
* Niagara Framework, Niagara 4 Framework, and the Niagara AX Framework are trademarks of Tridium, Inc. Echelon, LON, LonMark, LonTalk, and 
LonWorks are registered trademarks of Echelon Corporation. BACnet is a trademark of ASHRAE. Microsoft, Excel, Internet Explorer, Windows, 
Windows Vista, Windows Server, and SQL Server are registered trademarks of Microsoft Corporation. Oracle and Java are registered trademarks 
of Oracle and/or its affiliates. Mozilla and Firefox are trademarks of the Mozilla Foundation. All other product names and services mentioned in this 
publication that is known to be trademarks, registered trademarks, or service marks are the property of their respective owners. 
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Operating system requirements
The Installer program supports Professional and Enterprise level operating systems (OS) as shown in the following table. The Installer also 
supports installation on Windows Server 2012 and Windows Server 2012 R2.
Supported Operating Systems

Note: 
To install MultiSITE Supervisor on a Windows host, you must be logged in to Windows as a user with administrator privileges.

Java software
The Java SE Runtime Environment (JRE) 8 must be installed on any client PC that will access the station with a browser and MultiSITE 
Supervisor web profile. The free download is available at: java.com/en/ After installing JRE 8, ensure that the Java plugin for any earlier ver-
sions are disabled:
1.	 Under the Windows Start menu, click All Programs > Java > Configure Java > View.

•	 If the View button appears disabled, then only one JRE version is installed. Clicking Java > About Java (under the Windows Start menu) 
shows installed version(s).

2. Confirm that only the JRE 1.8 plugin is enabled, as shown in the following figure. For any version other than 1.8, click the check box in the 
Enabled column to deselect.

Operating Systems MultiSITE Supervisor MultiSITE Supervisor

Windows 7 / Server 2008 R2 (32-bit or 64-bit installation) Yes Yes

Windows 8 / Server 2012 (32-bit or 64-bit installation) Yes Yes

Windows 8.1 / Server 2012 R2 (32-bit or 64-bit installation) Yes Yes

Windows 10 /Server 2012 R2 (32-bit or 64-bit installation) No Yes

MULTISITE SUPERVISOR INSTALLATION
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Supported web browsers 
Following are the supported web browsers. It is recommended to have a HTML5 capable web browser. 

Web browsers MultiSITE Supervisor MultiSITE Supervisor

Google Chrome (mobile, tablet, desktop) Yes Yes

Microsoft Internet Explorer (v.10, v.11) Yes Yes

Mozilla Firefox Yes Yes

Safari (mobile, tablet) No Yes

Microsoft Edge No Yes

MULTISITE SUPERVISOR INSTALLATION

Figure 1:  JAVA Plugin.
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License requirement
You can install MultiSITE Supervisor on any PC with a supported Windows operating system. However, to successfully start MultiSITE Super-
visor or use the application framework, you must have a license file installed.

You only have to license the application on your computer once, typically soon after you finish installation by starting MultiSITE Supervisor.

Your product purchase creates an unbound license on the online licensing server. The server may email you a corresponding license key; 
this is a unique string that corresponds to your license.

32-bit vs. 64-bit installations
A number of factors determine which type of installation is required.

Many newer PCs run a 64-bit Windows 7 or later operating system (OS). The MultiSITE Supervisor 64-bit install provides certain advantages. 
Most notably, the 64-bit Java VM (Virtual Machine) does not have a 2GB memory limit. Coupled with a typical configuration that has 4GB or 
more RAM installed in the host PC, this allows a Supervisor host to run more effectively in a large installation. Depending on the PC host 
hardware, a 64-bit OS may provide other performance benefits.

However, in the following cases, it may be more effective to install the 32-bit version on a 64-bit Windows PC:
•	 When installing MultiSITE Supervisor on an “engineering workstation” that is licensed to run stations engineered for a LonWorks network 

(LonNetwork component) with the eventual intention of installing on a remote controller. The necessary underlying Ethernet drivers for LON 
FTT-10 USB adapters are only available for 32- bit Windows-based PCs.

Note that the term “engineering workstation” refers to an installation on a PC which is used to commission MultiSITE VM3 hardware and 
perform application engineering on both offline and online stations. In some cases the “engineering workstation” may also be licensed to run 
a station to facilitate application development and testing.

Note: 
Some late version web browsers have disabled support for NPAPI which prevents the Java Wb Applet from running in MultiSITE Supervisor. 
As a temporary solution, you may be able to enable NPAPI in the browser settings. Otherwise, you can use another browser that supports 
the plugin, or use the HTML5 HxProfile. 

Supported relational database software
The following table lists third party relational database servers that can integrate with MultiSITE Supervisor.

Database programs MultiSITE Supervisor MultiSITE Supervisor

SQL Server 2012 Yes Yes

MySql (v.5.6, v.5.7) Yes Yes

Oracle Express Edition (v.11g) Yes Yes

MULTISITE SUPERVISOR INSTALLATION
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•	 When your Supervisor contains limited RAM (less than 4GB). In this configuration, shorter 32-bit memory pointers could be advantageous. 
A station running in a 64-bit VM requires more memory than the exact same station running in a 32-bit VM.

Note: 
If you install a 32-bit MultiSITE Supervisor version on a 64-bit Windows OS, you could cause licensing confusion if you later install a 64-bit 
version on the same host.

If you attempt to install the 64-bit MultiSITE Supervisor version by selecting Installer_x64.exe on a 32-bit Windows OS, the Installer dialog 
displays an error which alerts you that it is not a valid Win32 application.
Determining installation type (32-bit or 64-bit)
You can determine which type of MultiSITE Supervisor installation is on a PC using either of the following methods:

•	 Make a platform connection to your local machine and look at the Platform Administration view. Check the JVM information which will 
indicate either win-x86 for a 32-bit installation, or win-x64 for a 64-bit installation. See the following figure. 

Or, 
•	 Make a station (Fox) connection, look at the Java Version property in the Station Summary view on the top level Station node, or else the 

Java VM Name property in the Platform Service Container Plugin view (default view of the PlatformServices container). Only 64-bit installa-
tions show Java Hotspot(TM) 64-Bit Server VM, whereas 32-bit installations show Java Hotspot(TM) Server VM.

MULTISITE SUPERVISOR INSTALLATION

Figure 2: Platform Administration.
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Downloading the latest build
Unless you have a copy on physical media, first download the latest build from Niagara-Central. This section explains the importance of 
extracting the files from the download before running the installer program.
1.	 If you don’t already have a copy, download the latest software zip file from Niagara-Central. 
2.	 Extract (unzip) its contents to a local folder.
Note:
You must extract (unzip) the zip file to a local folder before starting the install, and use the unzipped files for the installation. Although Win-
dows 7 and later operating systems allow you to see the contents of a compressed zip file and even to launch an executable without extract-
ing files, an attempt to install the software this way will fail.

COMMON TASKS

Figure 3: Installation files extracted from downloaded zip
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Installing MultiSITE Supervisor
The installation wizard installs both Niagara Framework and MultiSITE Supervisor on a Supervisor or engineering workstation.
1.	 Launch the installation program by running one of the Installer files located in the root of an installation CD or in the files extracted from a 

downloaded software zip file.
Note:
Installation CDs and zipped images can vary from one vendor (org) to another, consequently some installation items or dialog options men-
tioned in this document may not appear. Conversely, some CDs and zipped images may include additional installation items or options that 
are not covered in this document. 
2.	 Close other applications before you run one of the Installer files.

Running the installation program
The installation wizard lets you step through the installation program to make the necessary install option selections. The installation program 
windows have Next and Back control buttons. Click Next to advance to the next step. Click Back to return to a previous window to review or 
make a change.

•	 When installing an upgrade build to versions 4.0.13.0 and later, clear the browser cache prior to installation in order to remove any cached 
user interface images that may be changed in the upgrade. Otherwise, you may notice misalignment of some tool bar icons after installing 
the upgrade. However, if the cache is not cleared any such problem will self-correct within a 24-hr period since the browser cache lasts 
only for a day.

Steps
1. In the folder containing the extracted software zip file, right-click on the appropriate Installer file for your system (64-bit or 32-bit) and 
select Run as administrator.

Note: 
On launching the Installer, if you receive an error message stating that the software is not supported on the current operating system, it may 
be due to a file property setting. Check the Installer file properties Compatibility tab and make sure that the option to Run In Compatibility 
Mode is not selected. If it is, deselect it and run the Installer file again.

When launched, the installation program opens to the Welcome window. 

COMMON TASKS



16

LG
 M

ul
tiS

IT
ETM

 S
up

er
vi

so
r

Due to our policy of continuous product innovation, some specifications may change without notification.  
©LG Electronics U.S.A., Inc., Englewood Cliffs, NJ. All rights reserved. “LG” is a registered trademark of LG Corp.

2. On the Welcome window, click Next to continue.

3. On the License Agreement window, click Yes to accept the terms and then click Next to continue.

Figure 4: Welcome.

Figure 5: License Agreement.
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1. In the installation window, accept the default destination folder or if desired, click Browse to navigate to a different folder.

The default location is C:\niagara\niagara-4.x.nnn (where nnn is the build number). If needed, you can directly edit the folder path (for ex-
ample, changing the drive from C: to D:), or click Browse and navigate to another folder.

•	 If you change the default destination folder, you can click the Refresh button to recalculate the Space Required and Space Available 
values.

2. Accept or deselect, as needed, the two options that are selected by default:
•	 This instance of MultiSITE Supervisor will be used as an installation tool: Typically, you leave this selected.

This option installs additional files that allow the installation to be used to commission controllers. Always select this option for any Super-
visor host. This option installs the distribution (dist) files in the appropriate folders under the Niagara 4 version (software) folder. Using a 
platform connection, these files allow you to commission, or provision, a remote host to the same revision and build level as this Niagara 
installation.

•	 Install Documentation: This option installs PDF versions of the help files, hardware installation guides, and other manuals, which are 
available as PDFs, in the “!docs” folder. This option requires additional disk storage. This is not required for any functions, but it is recom-
mended for reference information.

These are the same PDFs that are in the “!docs” folder of the installation CD or zipped distribution file.

3. Click Next to proceed.

Selecting the installation location
This section describes selecting the location for the installation. The program provides the default location which you can change if you wish. 
It also provides options to use this instance of MultiSITE Supervisor as an installation tool and to install PDF versions of all documentation.

Figure 6: Select the location for the installation.
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Setting the system passphrase
If performing a new installation, the program prompts you to set a system passphrase for encryption purposes, as shown in the following 
figure.

•	 The system passphrase is used to protect sensitive information stored on all MultiSITE Supervisor systems, and on the SD card in Multi-
SITE VM3 controllers. 

•	 The system passphrase is assigned as the file passphrase for portable files, such as backups and station copies, and is used to encrypt 
those files. During operations in which you transfer encrypted files to a system (restoring backups, transferring a station, and so on), you 
are prompted to supply the file passphrase if it doesn’t match the system passphrase. 

•	 The system passphrase defaults to the factory default platform password. During commissioning, you will be prompted to change the 
default system passphrase. 

Note: 
You must remember the system password and keep it safe. If you lose the system passphrase, you will lose access to encrypted data. To 
change the system passphrase, use the Platform Administration tool.

1. In the Passphrase field, enter the passphrase and then repeat the entry in the Confirm Passphrase field.

2. Click Next to continue.

Note: 
•	 Once the installation program sets the system passphrase, you don’t need to perform this step again in subsequent MultiSITE Supervisor 

installations.
•	 A strong passphrase is required. Use 10 or more characters and include at least one of each of the following: uppercase, lowercase, and 

numeric.

Figure 7: System passphrase.
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Selecting install options
The options available to you differ based on the version of Windows installed on your PC or laptop.

1. Accept default settings or select your options and click Next to continue. 

If you are using Windows 7, your shortcut options are the following:
•	 Install Start Menu Shortcuts: This option is selected by default. This option creates a folder (group) of shortcuts in the Windows Start Menu.
•	 Install Desktop Shortcuts: This option creates a number of icon-based shortcuts on the Windows desktop.

If you are using Windows 8 or Windows Server 2012, your shortcut options are the following:
•	 Install Start Screen Tiles: This option creates tiles that appear on the Apps screen. The group of tiles is labeled, for example, MultiSITE 

Supervisor 4.1.13.0.
•	 Install Desktop Shortcuts: This option creates icon-based shortcuts to launch MultiSITE Supervisor from the desktop. 

Figure 8: Select options.
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Finishing install options
The final Finish Install window appears after the installation of all files. The options allow you to launch MultiSITE Supervisor immediately, 
install and start the platform daemon, and copy daemon data from the prior release.

1. Choose your option and then click Finish to complete the install window.

•	 Launch MultiSITE Supervisor: This option is selected by default, and recommended.
•	 Install and Start Platform Daemon: This option is selected by default. Any Supervisor installation, or engineering workstation PC that is 

licensed to run a local station requires that you start the platform daemon.
Installing the platform daemon automatically stops and replaces any other running platform daemon with the platform daemon from this 
release. Also, at any time you can install and start the platform daemon from any installed Niagara build, using the following Start menu 
shortcut: Install Platform Daemon.

The platform daemon runs as a Windows service. To verify that it is running, from a command prompt, type: services.msc and press Enter. In 
the Services window, double-click on the Niagara named service to see details, such as the software release and build number.

•	 Copy Daemon Data From Prior Version: This option is selected by default when the installer detects daemon data in an earlier version. 
When selected, the installer copies from the earlier version the stations, templates, and other files needed for the stations to run.

Note: 
Starting in MultiSITE Supervisor, if the installer detects that there is an existing daemon home for the version being installed, then this option 
is not available. This is to avoid overwriting a daemon home with an older version when reinstalling software or upgrading a newer version. 

For example, you may have existing MultiSITE Supervisor daemon homes and you install a newer version of MultiSITE Supervisor. If this op-
tion was selected, the installer would copy files from the N4.1 daemon home to the existing N4.2 daemon home, overwriting files there. This 
would most likely be an unwanted outcome.

COMMON TASKS
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Confirming the license
If you choose to launch MultiSITE Supervisor immediately and click Finish to exit the installation wizard, a license check routine occurs. A 
Check License popup window, and a License Installed popup window may appear.

Depending on which popup window displays do the following:
•	 If the License Installed popup displays (see figure below), click Continue. MultiSITE Supervisor continues to open. Note that another popup 

window (Platform Daemon Restart Required window) may appear, click Continue.

COMMON TASKS

Figure 10: License installed.

•	 If the License Request form appears in the browser (see figure below), enter the License Key string you received for this installation, along 
with other information requested on the form. After submitting this form, the licensing server should finalize (bind) your license and make it 
available for download, and also email it to you. If MultiSITE Supervisor successfully confirms the license online, restart the program after 
receiving the email.

Figure 11: License Request form.

MultiSITE Supervisor is now ready for use (without further license checks) on your host, for the duration of your license.



22

LG
 M

ul
tiS

IT
ETM

 S
up

er
vi

so
r

Due to our policy of continuous product innovation, some specifications may change without notification.  
©LG Electronics U.S.A., Inc., Englewood Cliffs, NJ. All rights reserved. “LG” is a registered trademark of LG Corp.

Getting started in MultiSITE Supervisor
Technical documents are available in the !docs folder as PDFs. Also, to view online help, open the Help window and explore the Table of 
Contents. 
Desktop shortcuts and tiles
Start Menu and desktop shortcuts for Windows 7 provide access to MultiSITE Supervisor from the Windows desktop. Tiles on the Start and 
App screens provide the equivalent for Windows 8 and Windows Server 2012.

The installer sets up shortcuts or tiles for the following applications:
•	 Alarm Portal 4.0.nnn (where nnn is the build) is a way to start MultiSITE Supervisor using an alarm profile. This mode limits most 

menu options to the support of the Alarm Portal view, which you can configure to monitor and acknowledge alarms from different stations. 
Alternatively, you can access the same view in the standard MultiSITE Supervisor interface, via the Tools > Alarm Portal selection. 

•	 Console: This shortcut opens a blue Windows command prompt window with the path set appropriately for command line utilities.
Note:
One command that may be useful is: nre -hostid. In cases where there are problems with the MultiSITE Supervisor starting, use this com-
mand to retrieve the Host ID of your Windows PC.

You can also open a console within MultiSITE Supervisor, by choosing Window > Console. The console area then appears at the bottom of 
the window.

•	 Install Platform Daemon: This shortcut installs and starts the platform daemon for this release and build of Niagara. The platform 
daemon is a server process that allows automatic station restart in case of reboot or failure, as well as remote platform management. To 
host a local station on this platform, you must install and start the platform daemon. If another platform daemon instance is running, Install 
Platform Daemon stops the running daemon and overwrites it with this daemon. 

•	 MultiSITE Supervisor (Console): This shortcut launches MultiSITE Supervisor with a separate, associated Console (black) win-
dow, which can be helpful in troubleshooting. This is similar to opening a Console (blue) window and entering the command: wb. Either 
console provides client debug messages, similar to the platform Application Director, which provides debug for the (server) station ap-
plication. If a client side error occurs in MultiSITE Supervisor, there should be some sort of stack trace debug in the wb console output.

Note:
If you start MultiSITE Supervisor this way, and then close the console window,the program also immediately closes. Any unsaved changes 
are lost. Be sure to save changes before closing the associated console window. Exiting MultiSITE Supervisor from File > Exit forces options 
to be saved. It also prompts for any unsaved files in the session to be saved or discarded.

•	 MultiSITE Supervisor: This shortcut launches MultiSITE Supervisor without an associated console window. If during installation you 
selected the option to start MultiSITE Supervisor upon completion, the application uses this shortcut to start the program when it finishes 
the installation process.

•	 Uninstall: This shortcut removes this Niagara installation. It provides separate options to save station files and user files.
•	 Demo Station: This shortcut launches the standard demonstration station outside of normal platform daemon control. As a convenience, 

the station launches using the station.exe command in a console window. 
If MultiSITE Supervisor is running, you can connect to the station (Open station). To save any changes made and stop the station, type quit 
in the Demo Station console window and press Enter. To stop without saving any changes, close the Demo Station console window.

Note:
Using station.exe is not the recommended way to start a local station. It is a developer utility that allows quick access to station debug mes-
sages in the console window. While the station is running, the console window can also process a few entered commands (to see them, in 
the console window enter: help). The recommended way to start a production station is to open a platform connection and start the station 
from the Application Director. This allows configuration for auto-start and restart on failure.
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File locations
During the MultiSITE Supervisor installation and platform commissioning processes, the software differentiates between two types of files: 
configuration and runtime data. This is based upon the content of the files. Files and folders that contain configuration data reside in separate 
locations from files and folders that contain runtime data. This separation enhances security by denying general access to the runtime files 
and allowing each user access to only their personal configuration files.

As a result of separating configuration and runtime data, the system supports multiple home directories on the Supervisor or engineering 
workstation. These homes may be identified as:

•	 The system home contains runtime files, such as core software modules, the JRE, and binary executables.
•	 MultiSITE Supervisor user home for each user contains configuration data, including option files, and registries.
•	 A platform daemon user home for the Supervisor or engineering workstation contains platform configuration data.
•	 Two station homes called protected station home and station home, are part of each user home.

COMMON TASKS
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Homes on a Supervisor
The following table provides a summary of the Supervisor or engineering workstation homes with shortcut information.

Home in the MultiSITE 
Supervisor Nav tree

Home in the Platform 
Administration view Niagara 4 alias Windows folder location and con-

tents File ORD shortcut

My Host > My File Sys-
tem > Sys Home System Home niagara_home

C:\niagara\niagara-4.x.xx

Executables and software files
! (as in NiagaraAX)

My Host > My File Sys-
tem > User Home N/A niagara_user_home

C:\Users\userName\
Niagara4.x\<brand>

MultiSITE Supervisor user home for 
each human user contains that user’s 
unique configuration files.

~ (unique to N4)

shared folder N/A station_home C:\Users\userName\Niagara4.x\tridium\
shared ^ (as in NiagaraAX)

stations folder N/A protected_station_home C:\ProgramData\Niagara4.x\tridium\
stations \<stationName> ^^ (unique to N4)

N/A User Home niagara_user_home

C:\ProgramData\Niagara4.x\<brand>
Platform daemon user home (non-
human user) holds platform daemon 
configuration files. Requires a local 
platform connection to view in the 
Platform Administration view.

~ (unique to N4)

Homes on a controller
On a controller there are two homes.

Home in the Platform 
Administration view

Home in the Platform 
Administration view Niagara 4 alias OFD location and contents File ORD shortcut

Platform > Remote File 
System > Sys Home 
(Read Only)

System Home niagara_home
/opt/niagara
Contains operating system data.

! (as in NiagaraAX)

Platform > Remote File 
System > User Home 
(Read Only)

User Home niagara_user_home
/home/niagara

Contains configuration data and the 
installed and running station.

~ (unique to N4)
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Performing a “clean” installation
This procedure describes steps to perform a “clean” installation for a subsequent build (other than a first time installation), which means that 
no files and folders from a previous installation are persisted.
Prerequisites:
Stop the Niagara service in the Windows Services maintenance console.

The files and folders in your MultiSITE Supervisor user home and in the platform daemon user home persist, so that all configuration data 
stored there is used by each new MultiSITE Supervisor build that you install. However, for troubleshooting or testing purposes you may prefer 
to start fresh rather than continue to use any of the files or folders from the existing installation. If that is the case, you can move or rename 
your existing MultiSITE Supervisor user home and platform daemon user home folders so that new ones are created by the installer.
Steps
1.	 Navigate to your niagara_user_home location (C:\Users\userName\Niagara4.x\<brand>) and rename the Niagara4.x folder.
For example, change the folder name to niagara4.0_myBackup.
2.	 Navigate to the platform daemon user home for the localhost (C:\ProgramData\Niagara4.x \<brand>) and rename the Niagara4.x folder.
For example, change the folder name to niagara4.0_daemonBackup. 
3.	 Run the installation wizard to install another build.
During the installation, the installer creates new Niagara4.x folders in both of those locations.

Uninstalling
During the Niagara installation, the appropriate Uninstall executable is copied to the !bin subfolder, and renamed to uninstall.exe. The in-
stalled Start menu Uninstall shortcut points to this executable.

Running the Uninstaller removes only the installation runtime files and folders in the niagara_home location

(C:\Niagara\Niagara-4.1.xx.xx). The files and folders located in your niagara_user home (C:\Users\userName\Niagara4.x\<brand>) and in the 
platform daemon user home (C:\ProgramData\Niagara4.x\<brand>) are left untouched.

1. Under the Windows Start menu, click All Programs and scroll to the Niagara build you wish to uninstall.

2. Click Niagara build > Uninstall. The Uninstall Program wizard opens.

3. Confirm that the wizard lists the correct build and click Next. The wizard notifies you as it immediately begins uninstalling.

On completion, the wizard notifies you that the uninstallation is complete.

COMMON TASKS
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Questions and answers in this section cover subjects ranging from the MultiSITE Supervisor directory structure to general Framework sub-
jects such as, installing individual modules and configuring your Windows firewall to allow for communication.

MultiSITE Supervisor FAQs
Following are some frequently asked questions and answers specific to the MultiSITE Supervisor.

Q: Why does an installation have so many “homes”?

A: The multi-homed directory structure results in improved security. Because configuration data is separated from runtime data, users do not 
require full access permissions to the installation. This allows administrators flexibility in regulating access. 

Q: The new station that I just created does not show up in the Application Director view. How am I supposed to start the station?

A: The New Station Wizard creates the station in your MultiSITE Supervisor user_home. To start the station in the Application Director you 
must first copy the station, using the platform Station Copier, to the platform daemon user_home .

Note that this scenario is true for early Beta versions. However in later versions the final (Finish) step of the wizard includes several action-
on-Finish options, one of which is: Copy station to secure platform for “localhost” on Finish. If selected, upon finishing, the wizard closes and 
the platform Station Copier appears.

Q: Why on my Supervisor PC am I required to make a local platform connection and the Station Copier to copy (transfer) a station to the 
daemon user home from my MultiSITE Supervisor user home, when I could more easily just use Windows Explorer to copy and paste folders 
and files there?

A: Bypassing platform tools, even with “localhost” operations, increases security risks. In the example cited, if you simply copy and paste a 
station folder using Windows Explorer, client passwords in that station are left in a portable format. Whereas if you use the Station Copier, 
those passwords become encrypted with the unique keyring files for the opened platform.

Q: Will other Windows users with admin privileges who log on to the PC where the installation exists be able to see the Start menu shortcuts, 
installation folders, etc?

A: The shortcuts are visible only to the original installer. Other administrator-level users, logged on to the Windows PC, can make their own 
shortcuts to MultiSITE Supervisor, etc., or simply navigate to the installation folders to start MultiSITE Supervisor. The result is that the user 
gets his/her own unique MultiSITE Supervisor niagara_user_home (C:\Windows\users\userName\Niagara 4.0, a separate location from that 
of the user who installed the framework.

Different Windows logons have different niagara_user_homes, by design, and it protects any passwords you may be using. This also means 
that sharing backups (and other items) with other users requires some thought.

Q: Is it possible to use MultiSITE Supervisor with an earlier release of Niagara installed on a controller?

A: No. You need to use a version of MultiSITE Supervisor that is compatible with the software on the controller. However, a remote AX-3.8 
controller can be integrated in the MultiSITE Supervisor’s station, where you can discover points, schedules, and histories. Also, if the Super-
visor is configured for provisioning, it can do provisioning tasks on a remote AX-3.8 controller. 

FREQUENTLY ASKED QUESTIONS
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General FAQs
Following are some frequently asked questions and answers on the Framework.

Q: From my engineering workstation, I need to support different jobs at different software release levels (for example: 3.7, 3.8, 4.0). Is there 
a recommended method to do this?

A : You can install different release levels on your workstation, and keep them separate by installing them in different locations. To run sta-
tions locally, remember to check which platform daemon is running at the time (from command prompt: services.msc and look at Niagara 
service). As needed, use the shortcut Install Platform Daemon to start the appropriate platform daemon.

Q: Is it possible to select which modules are installed?

A: By default, the installer installs all modules in your !modules folder. These include all the online versions of software documents, various 
lexicon modules, and all the software modules, including ones for drivers and other features. 

When you use MultiSITE Supervisor to install software in remote hosts (typically MultiSITE VM3 controllers), you select which modules to 
install. These include all the software modules in your !modules folder, as well as other items in your software database (!sw folder).

Q: Does Niagara require changes to my Windows Fire wall?

A: Most configurations work with the default ports. You would make changes to your fire wall to run a station locally on a PC with other 
remote stations connected to it, or to allow a remote MultiSITE Supervisor client to connect to the station and platform on this host.

Q: When installing Niagara on a Supervisor, is the software supposed to be installed with the “use as install tool” box checked? Is there any 
reason not to check this box?

A: This box is optional because the installation is 200MB bigger when it is selected. You need to have it checked if the Supervisor will be 
using provisioning to install software to subordinate controllers, or if you want to use MultiSITE Supervisor from that computer to upgrade 
software on a controller.

Q: What is the difference between wb w.exe and wb.exe?

A: Starting MultiSITE Supervisor using wb.exe starts an associated console window that provides debug information for the client MultiSITE 
Supervisor application in much the same way that the application director provides server-side debug information for the station. It is typical 
to start MultiSITE Supervisor using wb.exe when trouble shooting client side issues.

Starting MultiSITE Supervisor using wb_w.exe launches the program without a console window. You may prefer to use wb.exe because of the 
console. If MultiSITE Supervisor freezes with a console open, you can quickly terminate the program by closing the console window.

Q: I’ve got different versions of MultiSITE Supervisor installed. When is it really necessary to start the platform daemon?

A: You only need to start the platform daemon when you are planning to run a station locally. However, it may help if you get in the habit of 
loading the platform daemon for the current release each time you launch MultiSITE Supervisor. Some customers use batch files for start-
ing the platform daemon followed by starting the program. This simplifies things because you can just double-click the shortcut icon for the 
particular version and brand of MultiSITE Supervisor you need. Customers share such solutions on Niagara-Central. 

FREQUENTLY ASKED QUESTIONS
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